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1. Introduction to RAMDISK  

What is RAMDisk?    

RAMDisk is a program that takes a portion of your system memory and uses it as a disk 
drive.    

Conceptually, turning your memory into a usable disk drive may appear simple, but in 
practice there are many complex variables to deal with when operating a RAMDisk in 
Windows.  This software is designed to be user-friendly no matter what your PC 
knowledge may be.  Improvements will continue to be made to ensure new builds remain 
as easy as possible for end users.  Regular software updates will be provided to improve 
features and address customer requests.   

It is highly recommended that all users READ THE INSTRUCTIONS (this document) 
before trying the various RAMDisk settings.    

The below chart breaks out the different RAMDisk configurations that will be supported 
by AMD. 

 

How does it work?  

RAMDisk is a kernel-level driver that presents a standard disk drive to the OS. However, 
it stores and retrieves data from the system RAM on your motherboard instead of an 
actual, physical disk.  Along with the Kernel Driver is a GUI that talks to the driver and 
allows the user to set various options as well as start and stop the Driver (create or 
delete a RAMDisk).  

The Driver has been written to WDM standards and creates a low-level disk object that 
Windows Device Manager and Disk Management are able to "see" and manage.   

You can partition, format, mount a volume, and assign multiple drive letters to RAMDisk 
(but only if you would know how to do those things with a regular disk, RAMDisk does 
not do it for you).  
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Upon successful start of the RAMDisk, a kernel level driver (RAMDisk.sys) is loaded into 
the Windows/System32/drivers folder.  This driver will be available to Windows each time 
RAMDisk starts.  It is removed when RAMDisk is stopped.  

 

What is the benefit?  

In a word:  SPEED!    

Most users use RAMDisk to speed up applications like:  

• Databases  
• Internet Explorer cache for faster web surfing  
• Audio and Video editing  
• CAD programs  
• Software compilers  
• Speeding up CD duplication  
• Games  
• SETI processing  
• TEMP files  
• Swap space  
• Web server cache  
• Custom applications with high I/O, high bandwidth, or high security requirements  

Some users like the security of the RAMDisk because if you do not choose to back up 
the RAMDisk, all information will be wiped upon power loss or shutdown.  Since RAM 
cannot store any trace of information without power, you know the information is gone for 
good (not just hidden on a track of a hard drive that can be easily undeleted and even 
recovered after successive over-writes). 

An additional feature of a RAMDisk is that it will never wear out.  You can access it at 
maximum bandwidth 24/7/365 without fear of mechanical failure or fragmentation (a 
RAMDisk can become fragmented just like any other disk, but it does not take a 
performance hit like a physical disk does when it becomes fragmented). A RAMDisk 
operating at maximum bandwidth does not produce excessive heat, noise or vibrations. 
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2.  Screen-by-screen definition of settings    

Settings Tab  

 

This is the main GUI screen you will see each time you start the "Radeon RAMDisk 
Configuration Utility" program in the Radeon RAMDisk program group.   

File:  Under this menu item you can:  

Save Settings:  Saves your configuration settings  

     Restore Default Settings:  Restores the default settings, in case you need to get 
back to a known good state  
     Exit:  Exits the GUI, but does not affect the Driver.  Only Start and Stop will 
actually create or delete the RAMDisk 
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Purchase:  Under this menu item you can: 
 
 Buy Now:  This will take you to Dataram’s web site (the creators of RAMDisk) to 
allow the purchase of a license key for the full version of RAMDisk (no 4/6 GB limit, no 
pop-under reminders). Once the software license is purchased and successfully 
unlocked, this menu option will no longer appear unless there is a special promotion 
available. 
 
     Enter License Key:  After you purchase a license from the Dataram web site, you 
will be issued a 16-digit code that can be entered by selecting this option.  Once the 
code is entered successfully, the software will be unlocked, and this menu option will no 
longer appear. A license key is good for ONE computer.  Please be sure 
to enter the license key on the machine you wish to activate. 
***Please note:  If you wipe your hard drive, you may need to obtain a new license file.  
Please contact customer support to obtain one. 

Help:  Under this menu item you can: 

     User's Manual:  Opens this document 
 
 Support Center:  Takes you to Dataram’s technical support web site 
 
     AMD Website:  Takes you directly to the AMD Radeon RAMDisk homepage 
 
     About:  View version and registration information and get a link to AMD and 
Dataram home pages  

Disk Size: The below chart provides a recommendation of the size of RAMDisk you 
should create based on the amount of system RAM installed. 

 

• System RAM – The Amount of installed memory. 
• Recommended RAM Drive Size – The size of RAMdisk that should be created based on installed memory. 
• Format – Pre-formatted partition that allows you to see your disk immediately.  (FAT 16 can be chosen however it will not 

allow a RAMdisk larger than 4GB) 
• RAM Cache – The amount of RAM that should be set aside to handle unforeseen temp files 
• O/S RAM – The amount of RAM that should be set aside to ensure that the Operating System is fully supported properly. 
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The amount of memory reserved by RAMDisk for the OS is 512 MB. Therefore,     
the maximum size RAMDisk you can create = (Installed RAM) – (512 MB).   

Since you are using up some amount of your main memory to create a RAMDisk, 
you need to be sure to leave enough memory for your applications.  If you create 
too large of a RAMDisk, you may actually slow down your applications. 

FAT16 Partition:  You can have RAMDisk create a pre-formatted partition on the 
RAMDisk when it starts.  This will allow you to see the disk immediately in "My 
Computer" without having to manually format and partition the RAMDisk.  FAT16 is the 
simplest file system and is used for very small disks.  It is DOS compatible.  

FAT32 Partition:  You can have RAMDisk create a pre-formatted partition on the 
RAMDisk when it starts.  For disks greater than 32MB in size FAT32 formatting can be 
selected. Note that this results in a greatly reduced cluster size (.5kB for disks smaller 
than 260MB) and is much more efficient for disks that store a lot of small files.  

Unformatted:  This setting creates an empty RAM disk, without any partitions. You will 
not see this disk in "My Computer" until you format it with Windows Disk 
Management.  Note that if a disk image file is loaded, these settings will not be applied 
and the disk configuration will be the configuration of the saved image.  This is the best 
option to choose if you want to add the file system of your choice manually.   

Start RAMDisk: Pressing this button will start the RAM disk driver, creating a new 
RAMDisk.  Be sure you have the settings correct for your system before you hit "Start 
RAMDisk".  If you are in doubt, go to "File" > "Restore Default Settings".   As a 
precaution, the "Start RAMDisk" button will stop any currently running RAMDisk before 
attempting to start a new one.   If you have changed any of the RAM disk settings you 
will be prompted to save the current settings before starting the disk. 

In some cases, you will get a message informing you to reboot in order to start the 
RAMDisk.  Simply hit "OK or Cancel", exit the GUI and reboot.  Be sure you do not have 
RAMDisk set to "Load Disk Image at Startup" unless you are sure the *.img file selected 
is the one you want loaded.  After rebooting you should be able to start the RAMDisk 
with your selected settings.  

Once the RAMDisk Driver is started, it will stay running, even through reboots.    It 
will only stop when signaled to do so by hitting the "Stop" button. 

The Driver captures load and save *.img filenames and other settings from the GUI at 
the time of Start.  It is important to note that in order to change these settings, you will 
have to stop the Driver and restart.  If you make changes to the settings while the Driver 
is running, you will be prompted to stop the Driver before the settings will take effect.  

Stop RAMDisk: Pressing this button will dismount the RAM disk volume and stop the 
RAM disk driver, returning the memory used for the RAM disk to Windows.  In order for 
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the driver to unload successfully, there can be no open files on the RAM disk and 
Windows Explorer should not be displaying the contents of your RAM disk.   

If you are using "Background Update" or "Auto Save" you may not be able to stop the 
driver without a reboot, due to the fact that the disk is being accessed by the backup 
feature.  If the driver is unable to unload successfully, you will get an error message 
stating RAMDisk was unable to stop and advising a reboot.  Reboot and RAMDisk will be 
stopped.  

Boot Sector Settings:  You can select DOS or Windows boot settings.  These settings 
are only used when using RAMDisk as a master image file for a bootable hard disk or 
CD.  Some people see this setting and assume RAMDisk is bootable – unfortunately, 
you cannot boot from RAMDisk.  

 

Load/Save Tab 

 

Load Image Settings: These boxes allow you to configure the "Load Disk Image at 
Startup" feature, which will automatically start the Driver with the saved *.img file and 
associated settings.   
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Load Disk Image at Startup:  Check this box to have the *.img file shown in the 
"Filename" box loaded automatically when RAMDisk starts.  It is important to 
understand that this *.img file is not a standard disk image file, but rather contains some 
information specific to the RAMDisk disk geometry, so you may not be able to use other 
disk image management software to create, edit, or save a *.img file, even if the *.img file 
extension might lead you to believe you can.  The actual *.img file is not encrypted and 
can be viewed with hex editors, etc., and information can be extracted.   It is best to use 
this feature after you have your settings worked out the way you would like them.  

It is important to understand that once the RAMDisk driver is running, it continues to run, 
even through reboots, regardless of your settings in the "Load Disk Image on 
Startup" checkbox.  This setting simply tells the Driver to either load a pre-specified 
image to the RAMDisk (checked), or create a new, blank one (unchecked) upon startup. 

The disk image file must be accessible when the driver starts. For RAMDisks that you 
start and stop within a session (without a reboot) the disk image can be on any local 
drive. However, if you want an image to load at boot the image must be located on the 
system drive. Disk images cannot be loaded from network shared drives. 

If the Driver fails to load an image file (for whatever reason), it falls back on the rest of 
the configured settings, potentially giving you a formatted disk with Temp directory, etc. 
(depending on your settings), even though a perfectly good *.img file may exist.  Check 
for a moved or misplaced *.img file if this occurs. 

Loading a disk image when the driver starts at boot may take several minutes, especially 
for disks >1GB, so be patient.  

Create TEMP directory: This option will create a TEMP directory in the RAM disk when 
it is started.  If you have selected an "Unformatted" disk on the "Settings" tab, this 
option will not be available.  This option is also not available if you have selected "Load 
Disk Image at Startup".  This option is useful if you want to locate your temporary files 
directory on the RAMDisk disk. 

If you use the RAMDisk as the system TEMP directory (by changing the system 
environment variables TEMP and TMP) then keep in mind that many applications will 
use this space, including applications and applications installation programs. In 
particular, if an application installation program expects to write files to the system TEMP 
directory and then expects those files to be present after a reboot (to complete the 
installation) and you are not saving and restoring the disk on reboot, the application 
installer will fail and may leave your system in an unstable state. In addition, if the 
RAMDisk is too small the TEMP directory may fill up. Many applications do not handle a 
full TEMP directory gracefully.  

Disk Label: Selecting this option will allow you to specify an 11 character disk label for 
the RAMDisk drive.  This label will be created each time the RAMDisk is started.  If you 
have selected an "Unformatted" disk on the "Settings" tab, this option will not be 
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available.  This option is also not available if you have selected "Load Disk Image at 
Startup".  

Save Image Settings:  These boxes allow you to configure the "Save Disk Image at 
Shutdown" feature, which will automatically save the entire contents of the RAMDisk 
along with the associated Driver settings upon Shutdown. 

Save Disk Image On Shutdown:  Check this box to have RAMDisk save all the 
contents of the RAMDisk and the Driver settings to the *.img filename specified in the 
"Filename" field.  It is best to use this feature after you have your settings worked out 
the way you would like them.  Saving a *.img file with the RAMDisk set up correctly is a 
good idea, but be careful not to accidentally overwrite your only good file when you shut 
down by using this option.  

If an image file cannot be opened on shutdown, no image file will be created and a 
message will be sent to the Event Log. If there is insufficient disk space in the specified 
path, the output file will be truncated.  

For RAMDisks that you start and stop within a session (without a reboot) the disk image 
can be on any local drive. While you can save an image on shutdown to any local drive, 
if you want an image to load at boot the image must be located on the system drive. Disk 
images cannot be loaded from or saved to network shared drives. 

If the specified image file exists, it is renamed with a “.bak” extension and is not 
overwritten, unless this feature is disabled (see the Options tab).  

Saving a disk image at shutdown may take several minutes, especially for disks >1GB, 
so be patient. If you reset the system before the disk image save is complete, the disk 
image may be corrupted or lost completely.  

When saving a disk image to an NTFS filesystem, the RAMDisk driver automatically 
enables compression on the image file. This can be a significant savings in space, as 
well as greatly improve image save and load times. For best performance, locate your 
image file on an NTFS filesystem. Compression of the image file can be disabled in the 
Options tab.  

AutoSave:  Check this box to have RAMDisk Save all the contents of the RAMDisk to 
the *.img filename that was specified in the "Filename" field (locked in when the driver 
was started) at the specified interval.   The minimum time interval is 300 seconds. This 
interval is used to control a timer, and when this timer expires the system will check to 
see if the RAMDisk disk has been written to. If it has, the entire current disk image will be 
saved to the disk file specified in the "Filename" field. 

Use caution with this setting, you can keep a hard drive very busy with a large enough 
RAMDisk and a short time interval (thus negatively impacting your system performance).   
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Save Disk Image Now:  This button can be used to write a disk image immediately to a 
specified filename.  Normally, when the driver starts, it locks in load/save filenames set in 
the GUI at the time of the start.  Pressing the "Save Disk Image Now" button displays a 
popup that allows you to save an image to any local disk. The default location is the file 
selected in the "Filename" box, but you can select any location on a local disk. This 
does not override the “Save Disk Image on Shutdown” filename locked in when the 
Driver was started.  You will need to stop the Driver and restart it to change the Filename 
registered by the Driver. 

If the specified image file exists, it is renamed with a “.bak” extension and is not 
overwritten unless this feature was disabled when the driver was loaded (see the 
Options tab). Disk images cannot be saved to network shared drives. 

This button can be used to save a disk image even when the other save options are 
disabled. 

 

Event Log Tab  
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Scan System Log: This button will scan the last 1,000 entries of your Windows event 
log and display any RAMDisk related items.  The entries displayed can be double-clicked 
to pull up the full event message.  This is a handy feature for understanding why your 
disk may have failed to start or stop.  

   

Options Tab 

 

The Options tab allows you to configure some of the less commonly used RAMDisk 
options. 

Manually set RAMDisk timeout value: This setting allows you to configure the timeout 
value the configuration tool will use when starting the driver. When you start RAMDisk, 
the configuration tool waits for the driver to start and communicates with the driver to 
make certain that the memory requested for the disk was available. If the driver does not 
start in the allocated time, or signals an error condition, the configuration tool will shut 
down the driver. The timeout value is typically set by the driver based on the disk size, 
but you can override the default values and set them manually from this tab.   
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Do not create backup file when saving disk image: Ordinarily RAMDisk will not 
overwrite an existing disk image file, but will move it to a file with a “.bak” extension. This 
is an additional data safety measure in case an image file should become corrupted. 
Selecting this option will disable the creation of a backup file. While this saves disk 
space, it can risk the safety of your data.  

Do not compress image file on NTFS filesystems: Image files are saved as 
compressed files by default when the image is saved to an NTFS filesystem. This can 
provide significant reduction in file size as well as greatly improved load times for large 
images.  Selecting this option will cause the image file to be saved uncompressed. 
NOTE: NTFS compression is only supported for files < 30GB in size. This option should 
be selected for disks 30GB and larger.   

Clear RAMDisk memory on exit: Ordinarily when RAMDisk exits the disk memory is 
returned to the operating system. The disk data is still intact, and in principle it could be 
possible to extract the original disk data if the memory is not allocated for another use 
and overwritten. With this option set the entire disk image in RAM will be overwritten with 
0’s before the memory is returned to the operating system, completely destroying the 
disk contents.  
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3.  Technical Know How  

Swap Space   

The term "Swap space" means:    

"A swap file (or swap space or, in Windows NT, a page file) is a space on a hard disk 
used as the virtual memory extension of a computer's real memory (RAM). Having a 
swap file allows your computer's operating system to pretend that you have more RAM 
than you actually do. The least recently used files in RAM can be "swapped out" to your 
hard disk until they are needed later so that new files can be "swapped in" to RAM. In 
larger operating systems (such as IBM's OS/390, the units that are moved are called 
pages and the swapping is called paging." 

-TechTarget (www.whatis.com)  

You can see how confusion is bred by the multitude of terms used to identify "Swap 
Space".  Here is what you need to know:  RAMDisk can never be larger than the actual 
RAM you have installed on your system.  Some users think that because they have a 
large virtual memory, it will allow them to make a large RAMDisk. Users have also 
attempted to assign a RAMDisk as the "hard disk" to which Windows will begin swapping 
data when it runs out of RAM.  

You can assign the Windows swap file to the RAMDisk, but keep in mind that taking too 
much memory away from Windows can cause it to swap more, and if you are not careful 
the result can reduce performance.    

Temp Files 
 
There are many kinds of Temp files and folders in Windows.  There is a Temp directory 
that Windows will use to store files for IE cache, Windows Update scratch files, and other 
stuff, like WinZip scratch space, etc.  In general we will refer to any file that is not 
important enough to back up, a "Temp file".  This is an ideal kind of file/folder for 
RAMDisk to store, since the data is not important to preserve after initial use (in most 
cases).  Many users like to assign their temporary internet folder to the RAM Drive.  You 
have two important options to consider when doing this:  1) Do I save my data on 
shutdown?  -or-  2) do I want it gone for good?  If you want faster surfing, you should 
save on shutdown.  If you want absolute security for your web usage, you should not 
save on shutdown. 

If you use the RAMDisk as the system TEMP directory (by changing the system 
environment variables TEMP and TMP) then keep in mind that many applications will 
use this space, including applications and applications installation programs. In 
particular, if an application installation program expects to write files to the system TEMP 
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directory and then expects those files to be present after a reboot (to complete the 
installation) and you are not saving and restoring the disk on reboot, the application 
installer will fail and may leave your system in an unstable state. In addition, if the 
RAMDisk is too small the TEMP directory may fill up. Many applications do not handle a 
full TEMP directory gracefully.  

System Restore   

IMPORTANT!  Windows system restore may shut down if you enable it on a 
RAMDisk!  It appears that since the disk is too small or too transient to include system 
restore information, Windows can stop creating system restore points for all 
drives.  FIX:  You have to go into your system restore settings and disable system 
restore on the RAMDisk.   

"Found New Hardware" Message  

If you see this message after installing RAMDisk, something has gone wrong.  The 
RAMDisk driver is installed during setup, so Windows does not need to find a driver 
later.  If this happens, please use the uninstaller to remove RAMDisk, check the web site 
for any updates, and re-install.  If you have a corrupt install file, you may need to re-
download.  See also "Installing", below.  

Disk Images  

RAMDisk can save and load the entire contents of the RAMDisk to the system disk.  It is 
important to understand that this *.img file is not a standard disk image file, but rather 
contains some geometry information specific to RAMDisk, so you cannot use other 
software to create, edit, or save a *.img file, even if the *.img file extension might lead 
you to believe you can.  Like any file, the *.img file can become corrupted.  In fact, since 
RAM is inherently volatile, there is a risk of data loss or corruption any time power is lost 
or interrupted.  A corrupted RAMDisk can and will be saved to the *.img file either 
manually or automatically, depending on your settings. 

It is strongly advised that you keep any important information backed up on more than 
one *.img file.  Rotate your *.img file name from time to time, or better yet, use Windows 
backup to schedule periodic backups of the RAMDisk to a separate drive.  If your *.img 
file is lost or corrupted, it cannot be restored unless you have a backup.  If RAMDisk is 
set to automatically load image at startup, and that image is corrupted, you will get a 
corrupted drive every time, until you change the file name and/or Stop and Restart the 
RAMDisk. 

Since RAMDisk can only access image files through kernel file system I/O, large disk 
image files take a long time to back up and restore.  A 3045 MB disk image file may take 
up to several minutes to load and save.  If you have a very large disk image file, you 
must plan on much longer boot and shutdown times.  In practical use, the largest disk 
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files are more efficiently backed up by Microsoft backup or other 3rd party backup 
utilities.   

License Files  

RAMDisk is offered as “freeware” for use with disks up to 4GB in size. If you have AMD 
memory installed in your system, you will be able to use up to 6GB disk sizes.  If you 
purchase a license from Dataram you will receive a license file that will remove the 
advertisement window when you start the configuration tool and allow RAM disks larger 
than 4/6GB. To purchase the software, visit: 

www.radeonramdisk.com/xtreme  

Installing  

Be sure to install with Administrator privileges.  Also, you should not get any errors on 
installation (aside from any Microsoft warnings about unsigned drivers or Windows logo 
software warnings, depending on your security settings).  If you do, you may have a 
corrupt download.  Try re-downloading.  If you continue to have trouble installing, try 
disabling your anti-virus software.  Be sure to re-enable it after you install.  Be sure your 
file comes from Dataram.  Don't use files from other download sites.   

Uninstalling   

Be sure to STOP the RAMDisk before you uninstall.  If you get a message stating that 
RAMDisk could not stop, Reboot.  Verify the disk is stopped (the "Stop" button will be 
grey, and the disk will no longer appear in "My Computer").  You may then proceed with 
the uninstall.  

If, for some reason, you are unable to complete an automated uninstall, you can uninstall 
manually, using the following steps: 

1. STOP the RAMDisk.  If you get a message stating that RAMDisk was unable to stop, 
reboot. 

2. Exit the GUI 
3. Delete the program directory "C:\Program Files\Radeon RAMDisk" ("C:\Program Files 

(x86)\Radeon RAMDisk" in 64-bit Windows versions). This is the GUI directory. 
4. Search your computer for the file "RAMDisk.sys".  It should be in your root 

drive  \system32\driver directory (if RAMDisk is still running).  This is the RAMDisk 
driver.  It is created and removed when the driver is started and stopped.  If the file is 
there, it means the RAMDisk is running.  If it could not be found, it has been successfully 
deleted.  If the driver remains, delete it. 

5. If you are sure you no longer need them, delete any RAMDisk *.img files you may have 
saved (default location C:\RAMDisk.img).  That's it!  
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Support   

We value your feedback.  You can contact Dataram via the self-service support center at 
www.radeonramdisk.com/support	
  and you can be assured that we will do our best to 
help you.     
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4.  Frequently Asked Questions  
Do you have a question that's not in the FAQ, or have a suggestion for something that 
should be? Visit the support center at www.radeonramdisk.com/support.	
   

1. Can I run RAMDisk on 64-bit versions of Windows?  
2. Can I format a RAMDisk drive?  
3. How do I create an NTFS formatted RAM disk?  
4. Can I modify the partitions on the RAM disk?  
5. How do I create a bootable disk image?  
6. How do I set the drive letter for the RAM disk?  
7. Why doesn't the image file timestamp seem to be changing when I have 

AutoSave turned on?  
8. Can I boot from RAMDisk?  
9. The driver is started but I don't see a drive letter in My Computer.  
10. Can I use a RAMDisk as a raw drive for a virtual machine (VMWare or 

VirtualBox)?  

   
 

  
1.  Can I run RAMDisk on 64-bit versions of Windows? 
YES!  RAMDisk supports 64-bit versions of Windows Vista, Windows 7 and 
Windows 8.  
  
2.  Can I format a RAMDisk drive? 
Yes. RAMDisk drives can be formatted using Windows Disk 
Management.  It is not recommended using Partition Magic or other 3rd 
party disk management tools, since they have not been tested for use with 
RAMDisk. 
  
3.  How do I create an NTFS formatted RAM disk? 
Since much of the NTFS structure is undocumented by Microsoft, RAMDisk 
does not support creating an NTFS formatted disk explicitly (there is no 
"NTFS" button like there is for "FAT 16" and "FAT 32"). However, you can 
format a RAM disk using the NTFS file system by using Windows Disk 
Management. 
By saving and loading the RAM disk image on startup you can 
automatically start with an NTFS formatted RAM disk, since the disk image 
format overrides any other configuration settings. 
RAMDisk does not support dynamic disks.  Since Windows likes to keep 
track of dynamic disks, it gets upset when one is missing (like every time 
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you shut down a RAMDisk).  When prompted, it is best to set RAMDisk to 
"basic" disk type. 
  
4.  Can I modify the partitions on the RAM disk? 
You can modify the partition configuration of the RAM disk Windows Disk 
Management.  By saving and loading the RAM disk image on startup you 
can automatically start with the modified RAM disk, since the disk image 
format overrides any other configuration settings. 
  
5.  How do I create a bootable disk image? 
You can use RAMDisk to create a bootable disk image. The following 
example will create a disk image that can be used to create a bootable CD-
ROM. This simple example will just load the XP bootstrap, and can be used 
to start your XP installation. 
To begin with, start RAMDisk with the "Windows Boot Sector" option 
enabled (under the "Settings" tab).   
Go to the root directory of your XP system disk and do the following 
(assuming r: is your RAM disk):  

attrib -r -s -h ntldr  
copy ntldr r:  
attrib +r +s +h ntldr  
attrib -r -s -h boot.ini  
copy boot.ini r:  
attrib +r +s +h boot.ini  
attrib -r -s -h ntdetect.com  
copy ntdetect.com r:  
attrib +r +s +h ntdetect.com 

This will install the basic files necessary to bootstrap Windows 
NT/2000/XP.  For more information, see the Windows NT Workstation 
4.0 Resource Kit, p.697. Save the disk image. You now have an image 
suitable for creating a bootable CD-ROM. 

  
6.  How do I set the drive letter for the RAM disk? 
You can modify the drive letter using Windows Disk Management.   If you 
do not use Windows Disk Management, Windows will automatically assign 
the next available drive letter to your RAMDisk.  If you want a specific drive 
letter to appear each time you run RAMDisk, you will need to save the disk 
image at some point, and select "load disk image on startup".  Otherwise 
Windows does not know what drive letter you have created and will assign 
the next available drive letter.  Of course, selecting "Unformatted" on the 
"Settings" tab will create a blank disk with no formatting information, and 
therefore no drive letter. 
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7.  Why doesn't the image file timestamp seem to be changing when I 
have AutoSave turned on? 
RAMDisk keeps track of write activity to the RAM disk, and if there have 
been no writes since the last time the disk image was saved the disk image 
will not be written out again. This saves on unnecessary hard disk I/O, and 
can make a big difference if you have a large disk image that changes 
infrequently. 
  
8.  Can I boot from RAMDisk? 
No.  Since RAMDisk is a Windows resident program, you can't load 
Windows from it.  However, you can load a second OS instance from 
RAMDisk using a multi-session tool such as VMWare.  In fact, RAMDisk is 
often used with VMWare to increase its performance. 
  
9.  The driver is started but I don't see a drive letter for the RAM disk 
in My Computer. 
Use the Windows Disk Management to assign a drive letter to the RAM 
disk. 
 
10. Can I use a RAMDisk as a raw drive for a virtual machine (VMWare 
or VirtualBox)? 
The answer is yes, at least with VMWare. Configure and start RAMDisk 
first with an unformatted disk image, the start VMWare and configure the 
virtual machine for raw disk access.  If you stop and restart the RAMDisk, 
you will need to reconfigure the virtual machine for raw access to the 
RAMDisk; this is because some of the information kept in the vmdk file for 
raw disk access will not match after the RAMDisk is restarted.  After 
removing the old disk and reconfiguring for access to the RAMDisk the 
virtual machine will boot properly. 
 
VirtualBox as of version 4.1.10r76795 will properly install to an unformatted 
RAMDisk. However, the virtual machine does not recognize the disk 
properly if the RAMDisk is stopped and then restarted with the disk image.  
Reconfiguring a new vmdk to access the raw disk does not allow the 
RAMDisk to be recognized properly by VirtualBox. This appears to be a 
limitation of the VirtualBox software. 
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5.  Known Issues 

1. If the TEMP environment variable points to an invalid location, the following 
problems may arise: 

• Attempts to install RAMDisk may fail with an “Internal Error” message. 

• The RAMDisk configuration tool may fail to start with an “Invalid Picture” message. 

• Attempting to uninstall the software may fail with an “Internal Error” message.  

2. If the TEMP environment variable points to a location on the RAMDisk, the 
following issues may arise: 

• Attempting to uninstall the software may fail with an “Internal Error” message 

• You may be unable to stop the RAMDisk driver without rebooting.  

3. In many cases using RAMDisk will exercise parts of system memory that may 
never be used in normal operations, depending on the typical use of the system. 
We have found in many cases that RAMDisk exposes bad memory areas very 
quickly that otherwise were rarely (or never) accessed. If you are having problems 
with RAMDisk – typically BSODs or system freeze up - test your system memory 
using a memory diagnostic tool, such as memtest86 (http://www.memtest86.com) 
or memtest86+ (http://www.memtest/org). 

4. When using RAMDisk with Acronis backup and imaging tools the system will 
not boot properly when the RAMDisk is running, but will crash with a BSOD 
indicating that “snapman.sys” caused the system to shut down.  This driver is a 
key component of the Acronis product and is incompatible with Dataram 
RAMDisk. The system can be recovered by booting into Safe Mode and stopping 
the RAMDisk driver.  

This issue has been fixed in the latest version of the Acronis SnapAPI drivers 
(Version 586). The version 586 drivers can be downloaded from Acronis at:  

https://kb.acronis.com/sites/default/files/content/2010/10/15097/snapapisetup5
86.zip 

The Acronis Knowledge Base article with full information on this issue is at:  

http://kb.acronis.com/content/15097 

 

5. When you try to run the configuration tool you get an error message 
“Automation Error 80041010”. This can occur when objects in the system WMI 
repository are either missing or corrupt. You can rebuild the repository by issuing 
the following commands from a command prompt with Administrator privileges: 

https://kb.acronis.com/sites/default/files/content/2010/10/15097/snapapisetup586.zip
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net stop winmgmt /y 
cd %windir%\system32\wbem 
rename repository repository.old 
net start winmgmt 

When you issue the “net stop” command the system will also stop dependent 
services, so you may see messages about other services being stopped. If this is 
the case it would be best to reboot after this procedure to insure that all system 
services are properly restarted.  After this you should be able to start the 
RAMDisk configuration tool without error.  

6. The software “3TB+ Unlock” from Gigabyte is incompatible with RAMDisk and 
will cause a BSOD when both are enabled:  

http://www.gigabyte.com/microsite/276/3tb.html 

Dataram is currently working with Gigabyte to resolve this problem.  

 

Copyright 2008-2012 Dataram, Inc. 

RAMDisk is a Dataram product. AMD brand, technology names and logos used under 
license from Advanced Micro Devices, Inc. 

 
	
  

 




